FULL SPECTRUM LASER LLC V1.0
Software Usage Guide

Full Spectrum Laser LLC

Retina Engrave
3D Software Operation
# Table of Contents

LCD Touch Panel ................................................................. 1
Hardware Setup .................................................................... 6
Software Interface ............................................................. 11
File Menu ............................................................................. 11
Laser Menu .......................................................................... 12
Tabs Menu ........................................................................... 13
Help Menu ........................................................................... 13
Buttons and Features ......................................................... 14
Raster Image Modification Tools ........................................ 17
Raster Engrave Tab Overview .............................................. 19
DPI Selection ........................................................................ 20
Getting Better Raster Results .............................................. 20
Raster a Color or Greyscale Image ...................................... 21
Rotary Attachment Mode .................................................... 21
3D Engraving Mode ........................................................... 21
Case Study: The Effects of Up Scaling Following Direct Print ........................................................................ 26
Vector Cut Tab Overview ..................................................... 31
Vector Image Modification Tools ........................................ 32
Animation Timeline and Seek Controls ............................... 33
Rotary Raster Settings ........................................................ 33
General Usage ...................................................................... 34
Customizing the Interface .................................................. 36
Positioning When Raster Engraving .................................... 36
Working with Projects larger than 8.5”x11” ......................... 37
Auto-white Space Cropping .................................................. 39
Converting Curves to Hairlines: CorelDraw X5 ..................... 40
Joining Curves: CorelDraw X5 ............................................ 42
Designating Colors to Layers for Retina Engrave .................... 46
The Useful Repeats Function ............................................. 49
Combined Raster Engrave and Vector Cut ............................. 50
The LCD touchpanel provides convenient access to many laser features. The user is also able to store nearly an unlimited of jobs to a micro SD card (not included) located on the controller. The jobs can then be run from the touch panel without having a PC connected to the laser.

The buttons will perform different actions depending on what mode is selected and whether or not a job is currently running. The touch panel is capacitive touch-sensitive so will not operate correctly with gloves or objects other than your finger.
GETTING TO KNOW YOUR LASER

Starting up the Laser

When you turn on the laser the touch panel will display the following screen:

![Image of booting up screen]

Depending on your connection method, it can take up to 30 seconds to boot up and find an IP address. A static IP may be set through the software after the initial connection to decrease boot time. After booting up, the touch panel will show the following display:

![Image of booting up screen]
FX indicates that the laser is in Fast X/Y Jog mode. A001 indicates the last set of digits in the IP address.

The touch panel has 6 modes of operation:

- **Fast X/Y Jog (FX):** Arrow Keys jog head in X and Y quickly
- **Slow X/Y Jog (SX):** Arrow Keys jog head in X and Y slowly
- **Fast Z and Test (FZ):** Arrow Keys move Z up/down quickly
- **Slow Z and Test (SZ):** Arrow Keys move Z up/down slowly
- **File Mode (FF):** Reads files from SD Card (if inserted)
- **Load Defaults?** : Resets ethernet static IP address back to DHCP

Press the “**F/S Z**” button to cycle between the modes. The two letters in the bottom left corner of the LCD let you know what mode you are in. The default mode when starting the machine is Fast X/Y Jog.

**Lock/Unlock:** Press once to lock out the panel keys. The panel will remain locked until the button is pressed again. This button is active in any panel mode.

**Home/AutoFocus:** If in Fast XY (FX) or Slow XY (SX) the machine will home itself and remember the position. If in Fast Z (FZ) then machine will raise the Z table until the autofocus sensor is triggered then auto lower to the proper distance for the default focal lens. In Slow Z (SZ) the current position will be saved which can be used with the Return button.

**Return/Test Fire:** In Fast XY or Slow XY the laser will move to the previously saved job. In Fast Z and Slow Z mode, the button will test fire the laser for a 5 ms pulse. Use the fire button to align the laser.

**Perimeter button:** The perimeter button is used to align your work in the bed before starting the job. It moves the laser head around the minimum sized rectangle that your work will fit into. **To use the perimeter button you must have a job loaded from the SD card or the RetinaEngrave software.**

In Fast XY the bounding perimeter of the job will be shown quickly. In Slow XY the bounding perimeter of the job will be shown slowly. In Fast Z the controller will step through each of the 4 bounding perimeter corners once per press quickly. In Slow Z the controller will step through each of the 4 bounding perimeter corners once per press slowly.

**Start/Cancel:** This button cancels any current operation such as homing, autofocus or running a job. It is also used to load files and start jobs when in file mode.

**Jog Buttons (4):** In Fast XY Jog (FX) the laser moves in the XY plane quickly. In Slow XY Jog (SX) the laser moves in the XY plane slowly. In Fast Z (FZ) the laser moves the Z axis quickly using the up/down buttons. The left and right buttons will move in the x direction. In Slow Z (SZ) the laser moves the Z axis slowly using the up/down buttons (left/right buttons move the head in the Y
While Job is Running:
Only the lock/unlock buttons and cancel button work when a job is running. Lock/unlock pauses/resumes the job and cancel button cancels the job. All other buttons are disabled.

File Mode
This mode is used to load job files that have already been stored on the SD card. The files are saved as a job format (.bin) and stored to the micro SD card through the Retina Engrave interface. The micro SD card (not included) must be installed into the stellaris controller before turning on the laser.

To access file mode, cycle through the modes using the FS/Z button until you reach file mode (FF). From here you can see job files that are stored on the SD card. While in file mode, press the up and down arrow keys to scroll through the jobs. Press the right arrow key to see the storage size of the job (in bytes). Press the Lock/Unlock to delete a job from the SD Card.

When you have selected the job you wish to run, press the start button once to load the job into memory. Pressing the start button a second time will start the job. After loading the job you can press the down arrow key in file mode to dump the job from memory.
GETTING TO KNOW YOUR LASER

After loading a job into memory you can switch between modes to jog the laser head, run a perimeter, and raise and lower the z table. After you are satisfied with your position and z height, press the start button from any mode to begin your job.

Note: The speed and power are stored in the job files and cannot be changed through the panel.

Mirror Alignment Using the Touch Panel

The mirror alignment process is done by taping receipt paper over the mirrors and test firing the laser in different positions to produce dots on the mirrors. The preceding mirror can then be adjusted to align the invisible beam based on the location of the dots.

The user can complete this process by using the touch panel in Fast Z and Slow Z modes. The alignment from mirror 1 to mirror 2 is done in Slow Z mode. In this mode, the left and right keys move the gantry in the Y direction. The Return/Test fire button will test fire the laser in this mode.

After completing the alignment from mirror 1 to mirror 2, the user can switch to Fast Z mode to align the laser from mirror 2 to the final mirror. In this mode, the left and right keys move the gantry in the X direction. The Return/Test fire button will test fire the laser in this mode.

For more info on mirror alignment please refer to the following video: http://www.youtube.com/watch?v=jLgekkOiMsY

TouchPanel Alternatives

RetinaEngrave supports hotkey for all major functions. Full Spectrum recommends the purchase of a "bluetooth wireless mini keyboard" such as this one available from Amazon.com for around $25. This allows remote operation of all functions.
**Hardware Setup**

**USB Models**: Install the RetinaEngrave package and plug in the laser machine and start up RetinaEngrave. It should be auto-detected and connect immediately. USB models live stream the job from the host computer to the laser with a 3-5 second buffer. Do not overstress the computer or allow the computer to run out of power otherwise the job could be aborted.

**Ethernet Models**: Plug the Ethernet cable into a router, WiFi adapter or directly into the Ethernet port of the computer. Ethernet models automatically obtain an IP address over DHCP if plugged into a router or suitable WiFi adapter. The IP address will be displayed on the LCD screen indicating it successfully captured an IP address. Full Spectrum Laser recommends the Netgear WNC2001 or similar WiFi adapters available from Amazon.com for around $50. Other models may not function properly. Full Spectrum recommends plugging the ethernet cable into a router or WiFi adapter for easiest set up.

If you are directly connecting RetinaEngrave to your computer, ensure that your computer's IP address is set to autodetect by clicking the start button in Windows 7 and typing "Network and Sharing Center" then selecting "Change Adapter Settings" from the left bar. Right click on the computer ethernet card and select "Internet Protocol Version 4 (TCP/IPv4) properties.

Ensure the settings are set to "Obtain an IP Address automatically" or set to the following settings below:
OR
If the laser is plugged directly into a computer Ethernet port, the laser will delay for 30 seconds every time it is powered on before assigning itself a static IP address (typically 169.254.1.x). You must wait for an IP address to be obtained either through DHCP or static timeout before starting the RetinaEngrave software. (*Note that a static IP may be set from the software once connected to decrease the startup time significantly). The RetinaEngrave software will auto detect any suitable laser IP addresses if they are on the same IP subnet.

Ethernet models contain onboard SDRAM memory. The job is calculated completely, compressed then stored entirely on the controller for the most reliable operation even with a computer failure.

**Important:** When the software is started for the first time, it may ask you to for to allow access through the Windows firewall. You must accept. If you deny access you may need to go into the Windows firewall settings to allow access. If the software cannot connect to the RetinaEngrave Ethernet card, disable the Windows firewall by typing "Windows Firewall and Advanced Security" into the Windows start run box.
GETTING TO KNOW YOUR LASER
When starting the software for the first time, you will be prompted to select your laser model. **Choosing the wrong model can cause the laser to fire unexpectedly!**
Description of Menu Trees

File Menu

Open project or file will open files or projects for the user to engrave or cut. RetinaEngrave only natively supports XPS files and raster data types: .bmp, .jpg, .png, .tiff, .gif, etc through the File/Open process. 1-bit bitmaps are treated differently from other file types in that they are not resized. In 1-bit mode, each pixel represents 1 step of motion and the laser is fired if the pixel is black. This method allows advanced users to experiment with different imaging algorithms. However, the recommend method of getting data into RetinaEngrave is the direct print driver. Almost all file types can be opened in a program such as CorelDraw (corel.com) or the freely available Inkscape (inkscape.org) and printed to RetinaEngrave, bypassing the need to support individual file types.

Saving a project will save the raster and or vector data as an XPS document and will also save your settings as a .SET file. You can then open the project plus settings by choosing open project. Open project settings only will only open speed and power settings.
GETTING TO KNOW YOUR LASER

Laser Menu
The laser menu will display the model name of your particular laser.

Change laser allows you to change the configuration file to that of another laser model. This should never be used unless you own more than one Full Spectrum Laser model as it can cause the laser to fire unexpectedly.

Edit Laser Config allows you to edit the configuration file values such as speed and power. This is for advanced users only and modifying these values can cause damage to the laser head and or gantry.

RetinaEngrave Card Commands is used to load firmware files to the RE controller card. The Pro lasers and hobby advanced will have a Stellaris firmware file and an XMOS firmware file, the hobby lasers have only an XMOS firmware. When updating to a newer version of Retina Engrave you may be required to update the firmware. The firmware files are usually included in the software zip file.

When loading firmware, first make sure you show connected on the bottom left. Load the Stellaris firmware first (ProLF and new hobby only). When the process is complete you will show disconnected on the bottom left. At this point, reboot the laser and the software to complete the stellaris firmware update. Repeat the same process to load the XMOS firmware.

Static IP address is for users that connect the laser directly to their pc with the Ethernet cable or a fixed IP when DHCP is not available. This functions allows to flash a static IP address to the RetinaEngrave card. This IP address will always show up on the panel and the boot up time is greatly reduced.

Manual Reconnect will attempt to reconnect to the laser if you are showing disconnected on the bottom left.
GETTING TO KNOW YOUR LASER

Manual IP Address allows the user to manually specify the IP address to match the one shown on the laser touch panel. If you are unable to connect with Ethernet you should manually specify the IP that is displayed on the panel. Using Manual IP along with setting the static IP is the fastest and most reliable way to connect when using a direct Ethernet to laser connection (Ethernet cards only).

Save Job Data as File will save the work (including the speed and power settings) as a job file (.bin). When saving a job file, make sure you have the desired mode (Raster Only, Vector cut Only, Raster then Vector Cut) selected in the drop down box. You need to have “raster then vector cut” selected before saving if you wish to do a combined job.

After a job is saved, it can be stored onto a micro SD card that plugs into the Stellaris control card (see picture on page 4). With this feature you can create jobs on the software and then run them on the laser without ever having to connect the laser to the PC. This method requires the user to insert the micro SD card into their PC (adapter may be required) and save the job to it. They can then take the SD card and insert it into the control card on the laser. See the file mode section for more info on running jobs from the laser.

Send Job File to SD card allows the user to send an existing job file (.bin) to the laser IF they are connected to the laser AND they have a micro SD card inserted into the slot on the controller card.

Save and Send Current Job to SD card combines the preceding two features. It will first save a job file and then save it to the SD card on the laser (must be connected).

Materials and Focus Test allows the user to test power and focus settings with different materials. This feature is still beta and is only recommended for advanced users.

Tabs Menu
This menu allows you to choose which tabs are displayed. The tabs include: Raster, Vector, Design View, Rotary (optional upgrade), and 3D Engraving. If you accidentally close a tab it can be reopened in the tabs menu.

Help Menu
The help menu contains links for troubleshooting resources and software updates. It is also used to activate replacement control cards. If you received a replacement control card that needs activation, contact support@fslaser.com for more information.
Buttons and Features

1) **GO button**: Press the GO button to start the job. The laser will start the job starting at the TOP LEFT corner of the image and work its way down to the bottom right. When the job is finished the laser will return to the initial starting point. The GO button will be grayed out and not selectable whenever the USB cable is disconnected. In order to reset the controller, turn the laser off using the red E-Stop button, unplug the USB connector, reinsert the USB connector and turn the machine back on. Unplugging the USB port cable is also necessary on the hobby laser (on the Pro series the off button automatically resets the USB chip).

2) **PAUSE button**: After starting a job the pause button can be pressed to temporarily stop a job. Press pause again to resume the job.

3) **CANCEL button**: Pressing the cancel job will end the job immediately.

4) **Drop down box**: Raster Engrave Only, Vector Engrave Only, Raster then Vector Cut, Simulate Vector 0.5x, Simulate Vector 1x, Simulate Vector 4x. Raster data will come from any printed application. Vector data only comes from printed data that contains vector data. Examples of Raster only programs are MS Paint, Adobe Photoshop, Corel Photo-Paint. Examples of programs that can product raster and vector data are: AutoCAD, CorelDraw, Adobe Illustrator, MS Word.

The simulate buttons will trace the vector path in the retina engrave software at half, full and four times speed depending on which button is selected. Hit the simulate button and observe the red circle on the screen as it moves along the vector path.

5) **Current Position**: These text boxes show the current position read from the controller. These are reset to (0,0) when the HOME button is pressed.

6) **MOVE TO**: These text boxes show the saved position read from the controller. These boxes are editable, allowing you to move to an exact location if entered manually. If you have already homed the laser, the head will rapidly move to the specified position. If you have not homed the laser yet, pressing the MOVE TO button will first move the
laser head to the home switches for reference then rapidly move to the specified position. If your laser is a ProLF model, it will home to the top right of the bed and you will need to enter negative coordinates in the MOVE TO dialog. **Warning:** Always be prepared to press the E-Stop button in case the home switches do not respond to avoid damaging the laser mechanics.

7) **MOVE RELATIVE:** Use this to move the laser head a fixed distance in inches. Combine with the HOME button and the AUTOFOCUS button to set fixed points for fixtures.

8) **HOME button** Press the Home button to move the laser head to the home switches. The laser will measure the distance it takes to reach the home switches positions and enter these distances into the MOVE TO text boxes. It will then reset the CURRENT POSITION boxes to 0,0.

9) **JOG UP/JOG LEFT/JOG RIGHT/JOG DOWN/Z+/Z- buttons.** These move the laser head around. Check the SLOW JOG checkbox to slow the motion for fine adjustment.

10) **UNLOCK button:** Pressing the unlock button will unlock the stepper motors and you can move the laser head anywhere on the table by hand. This feature only applies to hobby lasers.

11) **ZOOM IN/ ZOOM OUT/ ZOOM RESET buttons:** change the zoom to inspect the project visual. Multiple presses may be necessary for any initial effect. Utilize the mouse wheel for the same effect.
12) **PERIMETER** button: Press this button will outline a box the same size listed in the bottom status bar (in this case 2.32"x2.67"). This will define the outer boundary of the work. Combine this with the beam combiner for optimal positioning.

13) **Perimeter Steps** button: This button will run one side of the perimeter box per mouse click. It is used to precisely align your piece in the work table. Press it four times to return to the original position.

14) **AUTOFOCUS** button: Press this button to move the Z axis up until the Z axis home switch sensor is triggered. On the 20x12 and 24x18 models this is a yellow induction based sensor. This sensor will turn on a red LED when the sensor is in range of the aluminum billet about 2mm before hitting the actual sensor. Always be prepared to hit the red E-STOP button on the front of the laser if it looks like the Z table is not stopping due to a failed or not enabled Z axis sensor. It is recommended the AUTOFOCUS feature be used only by experts familiar with the operation who are prepared to hit the E-Stop button whenever the Z axis sensor doesn't trigger to prevent damage to the laser.

15) **TEST FIRE** button: This button will fire a short laser pulse at the set time in milliseconds. RetinaEngrave defaults to a 5ms test pulse. 1-5ms is enough only to mark thermal receipt paper (not regular paper) and nothing else. This is the preferred method to align the laser as the laser power is so low it does not have the opportunity to mark or burn anything else at 1-5ms. Previous to v4 the hobby laser was test fired using the physical green test buttons. This procedure is no longer recommended as the test pulse is not finely controlled as it is through software control in RetinaEngrave v4. On the 60w and 80w machines, the minimum test fire duration must be set to at least 5ms due to the minimum amount of energy required to fire the laser being higher. Using the TEST button uses the maximum available current but limits the power by using the short duration. Do not set the duration higher than 5ms unless you know what you are doing.

16) **3D Engraving** button: Press this button to bring up the 3D engraving tab.

17) **Resolution drop down box**: Use this box to change the resolution when raster engraving. For best results, set this value to match your image resolution.
Raster Image Modification Tools

1) Rotate 90 Button: This button allows you to rotate an image 90 degrees. Will change a portrait orientation to landscape.

2) Mirror Horizontally Button: This button will mirror the image from left to right.

3) Mirror Vertically Button: This button will mirror the image from top to bottom.

4) Invert Button: This button will produce the negative image of what is displayed on the screen. I.E all the black pixels will change to white pixels and visa-versa.
5) **Trim Whitespace Button:** Use this to remove additional whitespace in the image after using the THRESHOLD slider. RetinaEngrave automatically removes whitespace for all non-zero pixels but the user can remove additional whitespace with the TRIM WHITESPACE button. Usage of this button is not recommended; instead, adjust the drawing in your drawing package to remove items you don't want to show up on the output before printing.

6) **No Dither Button:** Use this button to remove a previously applied dither from an image. This will only work if the image was dithered in Retina Engrave. (See 7 and 8)

7) **Simple Dither Button:** Dithering allows you to take a black and white image and simulate grayscale by applying an algorithm to average the pixels together. **Simple dithering uses the Floyd Steinberg algorithm.**

8) **Halftone Dither button:** Dithering allows you to take a black and white image and simulate grayscale by applying an algorithm to average the pixels together. **Halftone dithering uses the halftone algorithm and usually produces better laser engravings over simple dither.**
Raster Engrave Tab Overview

Select this screen before hitting the GO button to Raster Engrave only. If your image looks cut off or cropped, be sure to read the section of this manual showing you how to change the paper size in your program.

1) Raster Speed %: Sets the speed as a percentage of the maximum set in the config.xml file. Note: the raster routine in v4 is optimized so it only rasters non-whitespace and minimizes the acceleration distance. If you set the speed % very low such as 1% then the laser head does not need much acceleration distance. Total time to engrave = (acceleration time + raster time). Since acceleration time is also lower the total time is not linearly related to the speed %. However, the energy/heat applied to the material is linear according to the speed %. For deeper engraving use a slower speed.

2) Raster Power %: Sets the current as a percentage of the maximum in the config.xml file. Note: this function only works if your machine has the digital power controlled enabled. When the digital power control is enabled, the manual current knob will not function. If your laser has no current knob or the current knob doesn't function then the digital power is not enabled. Also note most lasers have a minimum
turn on current. Setting this value below this value will result in the laser not firing. Keep this in mind when settings power below 7-10%

3) Black/White Threshold: Adjust this slider to fade in or fade out portions of any image that is not black/white. Your computer graphics card must be fast enough to use the slider in real-time to see the updates. This has no effect on 1-bit bitmaps or black and white images. If you have a computer with a slow graphics card, set the threshold using the textbox and enter the values manually.

4) Ignore New Vector checkbox: Checking this box will only import raster data and ignore the vector data. When processing a print job, RetinaEngrave attempts to sort all the vectors for the fastest cut times. When the drawing contains millions of points or vectors then this can take a long time. Ignoring the vector data will allow faster print jobs if only raster is required.

DPI Selection

Full Spectrum recommends settings of 250x250dpi for most applications. Small text as low as 4point font can be done at 500x500dpi with excellent readability. 1000x1000dpi is for the most demanding applications. The DPI setting also affects the darkness because darkness = amount of heat = power of laser * speed of laser burn * number of times gone over. A typical CO2 laser beam diameter is around 0.002 to 0.005 inches. At 1000x1000dpi there will be overlap of the pixels. This function gives an averaging effect on the overlapped areas. 1000x1000 dpi will be much darker than 250x250dpi. However for most applications 250x250dpi at 50% speed will be much faster because there are less total acceleration/deceleration cycles.

The dropdown box affects the Import resolution as well as the Output resolution. The maximum printing resolution is set in the config.xml file and displayed in the control panel on the right. The final resolution is set to the maximum of the config.xml file setting and the selected DPI dropdown box. By selecting 1000dpi before printing, the laser will import at 250x250dpi then upscale this using bicubic interpolation to 1000x1000dpi.

RetinaEngrave stores the original color image in memory and converts it to grayscale then dithers the image. Due to the large number of pixels in a 1000x1000dpi (1 million pixels per square inch) image, your computer may run out of memory.

Computers with low memory should select 250x250dpi before printing because even at an import resolution of 500x500dpi(selectable in the configuration file), the memory requirements can be high.

Getting Better Raster Results

Using our RetinaEngrave software, you may turn your source image to a finished lase on your material of choice. There are several steps between those stages that are vital to your final output. Your laser understands two states, on and off. Every pixel or "laser dot" is either on or off. The question is how do we give RetinaEngrave the best "map" of these laser dots to accurately represent the original image?
GETTING TO KNOW YOUR LASER

RE takes liberties at different stages with your source material. When you direct print, RE is "sampling" the source image at the given size and reproducing it at the size of choice. RE takes liberties when the output DPI is set differently than what was direct printed. The software must output the image at identical dimensions to the source (inch by inch), but it must up sample to the native DPI of the laser. This means it must generate new pixels. There is no perfect method that adds or subtracts detail from an image, so this is imperfect.

How do you avoid these sources of frustration? The solution is to give RE a 1-bit image when you require exact output. 1-bit is perfect. It is always lased exactly as given with no liberties taken. Your best bet is to open your image editing software, set the project to the native dpi of the laser (1000 for Hobby) and dither your color or greyscale image, saving to a 1-bit BMP file. You have complete control within your image editing software when saving as a 1bit BMP. Drag this into RE and press GO.

Each laser must output at its native DPI. The hobby laser is set at 1000 for example and is a result of the resolution of the stepper motors. Images are handled differently depending on format. 1bit (black and white) images are the preferred source as each pixel is considered an even fraction of an inch (1/1000 in the case of the hobby laser). 1Bit images will always be output exactly as rendered. Choosing DPI selections other than 1000 result in a larger image as lines are simply skipped, "blowing up" the image, but output is still pixel perfect in regards to the source.

In the case of non 1bit BMP images (greyscale/color), dimensions are set on import using the page size in the print driver dialog box. Changing the DPI setting results in a different number of pixels in the same space, without changing the dimensions of the image. This procedure results in lower output quality that is not true to the source image. Non 1 bit images that are not evenly divisible by the native laser DPI (specifically 250/500/1000 for the hobby laser) should always be direct printed instead of loaded through the software, and should be rastered at the same resolution as they were imported (selected using the DPI selected box). See the case study below.

Raster a Color or Greyscale Image

Option 1: Process in image software such as Photoshop or Corel Photo-Paint. Dither the image to a 1 bit format and save as a BMP. Drop or file load through RetinaEngrave, adjust power and speed and press go. Using this method, RE is used simply to stage the image before output to the laser. Output will be 1:1 pixel perfect with the source BMP file.

Option 2: (using RE to process image). Open picture in any viewing software such as windows photo viewer and print to Retina Engrave using our print driver. Select the page size that fits your requirements. For example, in Windows Photo Viewer when selecting a full page print, selecting "letter" results in an image that fills an 8.5x11" page. In most cases, uncheck "fit picture to frame" to prevent clipping. In most cases, select 250 or 500 DPI within retina Engrave BEFORE import. Select Dither from image options, allow the dither to process and press go, ensuring that the "Master DPI" setting matches the selection chosen while importing. If image resizing is required, input a scale in the scale box (manual values are accepted) and click "set" before clicking Go.
Getting To Know Your Laser

Rotary Attachment Mode

Ensure the machine is turned off then replace the Y axis with the optional rotary attachment.

Activate the optional rotary attachment mode by selecting the Tabs/Show Rotary Tab.

Click the "Enable Rotary" checkbox to enable the rotary mode.

There are two major types of rotary attachments: Friction Wheel and Chuck Type which are selected from the drop down box.

Friction Wheel types are easiest to use. The settings should be preloaded and no additional changes are needed after selecting "Enable Rotary". The diameter does not need to be measured using a friction wheel type rotary attachment.
Chuck Style Rotary: Chuck style rotary attachments spin the object about the center and require careful measurement of the object diameter. Enter the object diameter into the appropriate text box and click calculate.

The other settings are automatically pre-calculated are not needed to be changed unless advised by FSL tech support.

Engrave objects by pressing the Play button and the object will automatically be scaled to fit the rotary settings.
RetinaEngrave 3D allows true 3D engraving from grayscale images by automatic separation of several raster jobs with separate power and speed settings per image. Activate 3D mode by Tabs/Show 3D Engraving Tab and then loading an image. Click Auto Generate Frames to load pre-calculated 3D settings for the image.
Case Study: The Effects of Up Scaling Following Direct Print

We have generated a small 50x50 pixel box. In the following illustration, the center box is the original size. This is direct printed using “Half Page” Format from Windows Picture Viewer. The left image is the actual size of what is generated from Direct Print. The right image is Retina Engraves interpretation of the Direct Print at 250x250 DPI. Observe the rounded edges due to the drastic increase in size.
If we then Select 1000 DPI within RetinaEngrave and Raster, we get surprising results. The image below and on the right is the actual output that is sent to the laser, including the anomalies along the edge. This is the result of (1) direct printing from a small source to a large output and (2) rastering at a much higher DPI than the project was direct printed at (1000 vs 250).
Below we take the corner of the same project and output it at 500 DPI instead of 1000. The effects are still visible although not as severe as 250->1000.
Below we Direct Print at 500 DPI and output at 250.
When we import at 250 DPI and output at 250 DPI, we find the best results because import and output DPI are identical (below). The software must up sample to 1000 DPI in order to lase, resulting in an image $\frac{1}{4}$ the size of the original. In order to output at the same dimensions as the source, the software skips 4 lines for every line of output on the Y-Axis. In this way, no scaling is required and no anomalies are introduced as pixels need not be generated before output.
Vector Cut Tab Overview

Select this screen before hitting the GO button to Vector Cut only.

1) Ignore Raster: Select this option to speed up processing of large vector files on computers with limited memory since the raster data is very memory intensive for large drawings at the highest resolutions and is unneeded if only vector is required.

2) Vector Current %: Total power can be set two ways: Global current control by setting the maximum current the laser can consume or by PWM gating (turning the laser on/off quickly) of the output beam. In raster mode, only current control is available because the laser is pulsed at high speed. In vector mode, both of these settings are available.

3) Vector Layers: RetinaEngrave automatically separates drawings by color. Each layer can specify different properties.
   - Layer: The designated color of the layer.
   - Order: Layers are cut in order of 1-7.
   - Speed: sets the speed of the layer as a percentage of the maximum value in the config.xml file. To cut deeper set the value lower. Generally to cut through the material we use values around 10-20% speed.
GETTING TO KNOW YOUR LASER

- **Power %**: sets the amount of PWM on/off time. PWM power control is very fine. Setting it to 0.5% will mark but not cut through paper.
- **Repeat**: Set number of repeats of the layer at the chosen power/speed settings. Set to 0 to ignore the layer.
- **Contained Objects First**: The software uses two algorithms to calculate the order and path the laser head travels to complete a job.
  - Algorithm A orders polylines inside-out (Contained Objects First Checkbox is checked). All polylines are placed in a tree structure with parent-child relationships to the polylines that contain them or are contained respectively. We then build an ordered list and calculate the nearest entry point of each successive polyline to the end point of the polyline before it, building an optimized path starting with the innermost object. This algorithm results in consistent, repeatable paths as well as shorter job time due to the polyline entry point optimization. This takes slightly longer to process than the Algorithm B.
  - Algorithm B (Contained Objects First Checkbox is unchecked) does not take advantage of polyline entry point reordering or the relation of polylines as far as containment or proximity. This algorithm plots points as they are loaded from the source file, resulting in paths that often skip around within the job. This calculation can result in different paths when loading the same source file on multiple occasions as well as longer job time. Processing time is faster using this algorithm, however.

Vector Image Modification Tools

The buttons on the left allow you to rotate an image and mirror horizontally and vertically. The arrow on the bottom left allows you to rescale the image vertically. The top right arrow allows you to drag and rescale the image horizontally. The square on the bottom left allows you rescale the image while keeping the same aspect ratio. The height and width are displayed in inches and will update when the image is resized.
Animation Timeline and Seek Controls

When clicking the “Get Time” Button while viewing a vector project, an animation timeline is created based on the color and speed attributes of each layer present in the project. Each colored bar represents a complete polyline and the size is proportional to the total time dedicated to that polyline during a Vector Job. The ticks above the bar represent the entry points or starting location of each polyline. You may click and drag the blue Seek Control Button to inspect the starting location of each object in the Vector Tab. This is only available when the job is not running.

Rotary Raster Settings

Set up the job to use the optional rotary attachment using this screen. Click on the “View” Menu Item and select “Show Rotary View.” Click the ENABLE ROTARY checkbox then hit GO to rotary engrave. Be sure to turn your laser OFF before hooking up the rotary attachment. Be sure to hook up the rotary attachment BEFORE hitting GO. The other settings have been recomputed for the 20x12 and 24x18 Pro lasers.
General Usage

**Step 1**) Open up RetinaEngrave USB by double-clicking the icon. Leave this running in the background or minimized. If you close the program, the direct print function will not work because the program cannot capture the print stream from Windows if it is closed. However, you can print to an XPS print file while RetinaEngrave is not running and open this XPS file at a later time to print.

**Step 2**) Print from any application and select the Full Spectrum Engineering Driver as the printer. Vector mode will only capture Vector output. Vector mode has been tested with many different vector programs such as CorelDraw X5, AutoCad 2011, Inkscape, Adobe Illustrator, Draftsight and more as shown in our demo videos. However, if you have problems vector printing to RetinaEngrave, use CorelDraw X5. Read the tips on CorelDraw on our forums how to import most file types such as DXF files into CorelDraw. Raster mode should print from any program.

**Step 3**) Vector Mode: RetinaEngrave generates vector information from XPS files directly. All other file types must be opened in their native application or CorelDraw and Direct Printed. Alternatively, print to the "XPS Document Writer" and open the resulting .XPS within RetinaEngrave.

**Step 4**) Raster Mode: RetinaEngrave can also open .XPS files and BMP Files to generate Raster images. However, RetinaEngrave handles 1-bit bitmaps differently from other formats as it does not rescale a 1-bit bitmap. In 1-bit mode, 1 pixel = 1/1000 of an inch or 1/500 or 1/250 depending on the selected output resolution. If the pixel is black it will fire the laser; otherwise, it does not fire. 1-bit bitmaps produce the most predictable output. Other image formats are opened with best effort conversion and up-scaling. You can generate your own 1-bit dithered images for grayscale effects. There is a tutorial using Adobe Photoshop to generate 1-bit bitmaps on www.fullspectrumengineering.com/forums.

**Step 5**) Adjust the threshold setting to include or exclude portions of the drawing if in Raster mode. Adjust the power and ordering with various color settings if in Vector mode. Visit http://www.fullspectrumengineering.com/forums for more advanced options and tips.

**Step 6**) If in Raster mode, select the DPI. 1000x1000 dpi means there are 1000 left to right sweeps per vertical inch. 250x250dpi means the laser only sweeps 250 times per vertical inch. Higher DPI will also engrave deeper because the average laser on time per unit area is higher. Engraving at 250dpi will be 4x faster than 1000dpi.
Step 7) Press the "Go" button to start the cutting. The cutting happens in the background. While every effort is made to efficiently multi-thread the process, avoid doing intensive computer tasks while cutting because the trajectories are calculated on the fly by the computer. Also monitor the progress of the cut on the lower right hand corner. RetinaEngrave has a large buffer so may continue engraving even after the computer has reached 100%.

Step 8) Look at the "config.xml" file in the install directory in a text editor for more configuration options (advanced users only).

Step 9) Go into "Control Panel\Hardware and Sound\Power Options\Edit Plan Settings\Change advanced power Settings" and make sure "USB settings\USB selective suspend setting" is disabled.
Customizing the Interface

Panes and tabs are able to be dragged and repositioned to increase workflow.

1. Relocating the Control Panel as shown: Left click and hold, dragging the panel out of the window. This may also be “snapped” back into place by dragging it back within the main window.

2. Setting up Horizontal Tab Groups as shown: To see Vector and Raster tabs concurrently, right-click on the Vector Cut Tab and select “New Horizontal Tab Group.”

3. Restoring layout: Restart RetinaEngrave to reset the layout. You may also drag the tabs back to the original position and the software will reinsert them.

Positioning When Raster Engraving

When you raster an image, the laser head must ramp up/accelerate to the desired speed over some distance at the start of a line and must ramp down/decelerate to a stop at the end of a line. RetinaEngrave is designed so that the first pixel is placed where you hit the GO button. The laser head will move left then accelerate towards the right so that it reaches the desired engraving speed at the initial position. For this reason you cannot start the job at the far left. Leave around 1” on the left side and right side so the laser head has room to accelerate and decelerate.
Working with Projects larger than 8.5”x11”

While working with large projects, the paper size within the printing options must be changed to accommodate the larger size. This is done at time of printing and is independent of the software you are printing from. To engrave or cut large sizes, change both the paper size and the page settings as shown in the image below. Select Tabloid (11”x17”) or C size (11”x22”) or D size (22”x34”). It is not necessary to have the page size the same as the paper size. Instead, ensure that the page size is larger than the dropping. Paper sizes that are smaller will crop the image. RetinaEngrave automatically crops all whitespace from the image so the first non-white pixel is at position (0,0) top left.
Select Preferences->Advanced and change the paper size.
Auto-white Space Cropping

As mentioned previously RetinaEngrave automatically crops away white space on the page. This design was intentional to allow the use of programs like MS Word where you cannot set the exact position of the output easily on the page. To prevent cropping, draw a yellow rectangle around your objects as the desired size. In RASTER mode, use the THRESHOLD button to fade away light colored lines. In VECTOR mode, set the REPEATS of the yellow layer to 0 to ignore this line. In the following two images the first has a yellow box drawn around the items. When this image is printed, it is cropped to the yellow box outline and the size is 6.71”x3.48”. In the second image the yellow box is omitted. The image is cropped to the extents of the non-zero pixels and produces an image that is 4.77”x1.22”. This feature is particularly useful when trying to align the drawing on existing material. For example, if you have a 4”x6” wood plaque that you want to engrave, measure the size of the plaque then draw a 4”x6” yellow box this size in your drawing. Put the text inside this box. Set the position of the laser to the top left hand corner of the wood plaque and press GO and it will raster exactly the same size as you have laid out in the drawing.
**CONVERTING CURVES TO HAIRLINES: CORELDRAW X5**

In vector mode, lines should be reduced to the minimum thickness allowable by the drawing program. In CorelDraw X5, these are known as *hairlines*. If lines are not reduced to hairlines, RetinaEngrave may trace the boundary of the line instead following the center of the line during vector cutting.

1. Left Click: Edit -> Select All -> Objects. This will select all objects.
2. Left Click: Outline Pen Tool -> Hairline Outline. This will change the width of all lines to Hairline.

In this example object our line width is 0.5
After applying Hairline Outline our line width is now Hairline (thinnest possible)

Joining Curves: CorelDraw X5

For predictable output, vector drawing should be closed as much as possible. Many times vector drawings (in particular DXF files) may have small breaks that will confuse the RetinaEngrave print driver.

CorelDraw X5 has a great command: Arrange ->Join Curves. This will join touching lines into a closed path suitable for laser cutting. In this example our object is 1” width by 0.282” height.

At 500% zoom the object appears to have all lines connected.
However at 6400% zoom on the bottom left corner of the same object we can see that some of the lines are merely touching and are not connected.
1. Select all objects you want to correct. Left Click on Arrange/Join Curves.

2. The Join Curves window will appear on the right side of your screen. Click Apply.

Note: The default settings of: Extend and Gap tolerance 0.1” should be sufficient for most users.
Here is the same object at 6400% zoom - all lines are now connected and we have a closed path.
Designating Colors to Layers for RetinaEngrave

Designating a color to objects/ layers you want to vector cut enables you to take advantage of RetinaEngrave USB’s ability to specify cutting order, cut speed, laser power, and number of repeats to each individual layer.

Currently, RetinaEngrave USB supports up to seven standard color layers for maximum program compatibility: **Black**, **Blue**, **Red**, **Magenta**, **Green**, **Cyan**, and **Yellow** from the RGB color palette.

RetinaEngrave uses a best guess color round off routine when a color is not a standard RGB color. Avoid **Black** whenever possible because this is the default color RetinaEngrave uses whenever it cannot figure out what color it should be. By avoiding **Black**, you will have more control.

Always assign the **outline stroke** (the object border) the desired color and not the fill of the object. Always use an empty fill when possible.

1. Open your .cdr vector format file in CorelDraw X5.
2. Make sure you have the Object Manager window open by **Left Clicking**: Tools, Object Manager
3. **Right click** on the object in the Object manager that you want to designate a color to.
4. **Left click** on “Properties” in the pop-up window

In this example image we have seven objects on seven different layers.

5. In the Object Properties window **Left Click** on the Outline Pen tab.
6. In the Outline Pen properties window **Left Click** on the down arrow next to “Color:” to change the outline color of the currently selected objects to one of the seven supported colors.
In our example image we have changed the outline color of one object to blue. It is possible to have more than one object the same color. In our example image all objects that have a black outline would be considered to be on the Black layer in RetinaEngrave USB and the single object with the blue outline would be considered to be on the Blue layer in RetinaEngrave.

7. Repeat steps 3 through 6 as necessary to change the outline color of objects, specifying one of the supported colors to each layer of objects up to a maximum of seven.

In our example image we have changed the outline color of seven objects, one on each layer.

8. When your image is finished be sure RetinaEngrave USB is running in the background and File/Print using our Direct Print Driver.

9. Switch the current program to RetinaEngrave USB and Left Click on the Vector Cut Tab.
10. In the layer settings table within the Control Panel you can now change each colored layers cut settings.

**The Useful Repeats Function**

The repeat function allows you to automatically do multiple passes.

**Want to ignore a layer?** You can set Repeats=0.
Combined RasterEngrave and VectorCut

RetinaEngrave supports combined raster engraving and vector cutting in the same job. In this section, we describe the process of using CorelDraw X5 to properly prepare your image before direct printing to RetinaEngrave.

1. Using the methods from our tutorial on designating colors to layers, designate either yellow or cyan to the layers you want to vector cut and designate black to the layers you want to raster engrave.

In our example image we want to:
1) Engrave the text and the four corner objects in raster mode by changing them to black.
2) Cut the middle object and the outside border in vector mode by changing them to yellow or cyan.

![Image showing layers and colors for vector and raster operations.]

Note: In a combined raster/vector image you can designate yellow and cyan to different vector objects. This allows you to adjust cut settings (speed, power, etc) in RetinaEngrave’s Vector Cut mode for both the yellow layer and the cyan layer.

Example image after designating black to raster objects and yellow/cyan to vector objects:

![Example image showing the final output after color designation.]

Note: Make sure that any text that is “Artistic Text” in CorelDraw X5 has a Hairline outline applied.
2. Verify RetinaEngrave is running in the background.
3. File → Print using our Direct Printing Driver.
4. Switch the current program view to RetinaEngrave.
5. Verify you are in RetinaEngrave’s Raster Engrave mode by using the pull down menu and selecting Raster Engrave Only.
6. Adjust the slider on the threshold setting to fade out/in objects. RetinaEngrave will only raster what is visible on the screen. Adjusting the slider to the left will fade out objects, while sliding to the right will fade in objects. You can also adjust the threshold by manually typing a value into the box next to the threshold slider between 0.000 and 1 and then left clicking on the image. The maximum threshold value of 1 will make the image solid black and should not be used. For optimal results first adjust the threshold almost all the way to the right to a value of 0.999.

Note: In RetinaEngrave’s Raster Engrave mode all objects will show as black. The objects designated as yellow or cyan in CorelDraw X5 will fade out before the objects that were designated as black will fade out.
Slowly adjust the threshold setting to the left until the vector objects that you previously designated yellow and/or cyan in CorelDraw X5 completely fade out, leaving only the black raster objects visible. In our example image we found that a threshold setting of 0.96 made the center yellow vector object completely fade out. The cyan vector border has not faded out and further threshold adjustment is needed.

Further adjustment of the threshold to the left to a value of 0.9 makes the cyan vector border completely fade out. The threshold for our example image is now properly adjusted leaving only the black objects that we want to raster engrave visible. The end goal when adjusting threshold value is to adjust the threshold to the left just enough to make the yellow/cyan objects fade out while leaving the black raster objects highly visible for optimal detail raster engravings. Threshold settings for your particular image could vary from our example image settings.
7. Adjust the Speed % and DPI to your desired settings.
8. Left Click on the “Go” button to raster engrave your material.

Note: When the raster engrave process is complete DO NOT move your material inside the laser cabinet. Both Raster Engrave mode and Vector Cut mode in RetinaEngrave use the same “home” point for where the laser starts it’s engrave/vector process. As long as the material has not been moved between the raster engrave process and vector cut process the image will line up correctly on your material after finishing the vector cutting process.

9. Switch to Vector Cut mode by using the pull down menu and selecting “Vector Cut Only”.
10. Adjust the Black layer’s “Repeats” setting to 0(zero). This will tell the laser to ignore all the Black vector objects.

11. Adjust the yellow and/or cyan layer(s) to your desired cut settings.
12. Left Click on the “Go” button to vector cut your material.
13. When the vector cut process is complete, the combined raster/vector job is finished and you may now remove your material from the laser cabinet.